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Microsoft®
 

Word 2013  
 
 

Lesson 1: Getting Started 

Lesson Objectives
This lesson teaches you to create simple documents and introduces you to some file management tools 
available in Word. Upon completion of this lesson, you should be able to: 

 identify elements on the screen 

 use the Quick Access Toolbar 

 use the Ribbon 

 work with text 

 move around the document 

 use Backstage to save, open, or create new documents 

 switch between documents 

 save in different file formats 

 close a document 

 add document properties 

 open and edit PDF files 
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Looking at the Screen 
When Word starts, it displays a screen similar to the following Backstage view: 

 
At this point, you can choose to create a new blank document, create a new document using an existing 
design or template, or open a file from a specific location (discussed a bit later in this lesson). For the 
purpose of viewing the Word screen, we will create a new blank document. 

 

Collapse the Ribbon 

Insertion 
Point 

Ribbon Group 

  Quick 
 File Access Ribbon  Help Ribbon 
 Tab Toolbar Tabs Title Bar  Display 
       Options 

 Status  View Zoom  Zoom
 Bar Buttons Slider Level
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File Tab When clicked, this displays the Backstage view from which you can select commands 
for a file (for example, New, Open, Save, Print). A panel at the left displays commands 
that may include tabs with a set of sub-commands to manage the file. 

Quick Access 
Toolbar 

Located above the Ribbon, this provides quick access to frequently used commands. 
You can customize the toolbar to contain commands you use regularly. 

Title Bar 
 

Located at the top of the screen, this displays the name of the document currently 
contained in the window (for example, Document 2 – Microsoft Word, Letter to J. Woods 
- Microsoft Word.) 

Ribbon Tabs 
 

Each tab represents a group of commands for specific purposes such as editing, 
inserting graphics, viewing options, or page layout. 

Microsoft 
Word Help 
 

Displays the Help window where you can obtain the latest help on a feature; 
Microsoft’s Help option links to the Microsoft Web site for the latest information. You 
can also use the help topics installed with Office. 

Ribbon 
Options 

Click this to show or hide items for the Ribbon, such as the tabs only or the tabs and 
commands, in order to display more data on the screen. 

Ribbon Group 
 

Each group in the Ribbon contains related commands to edit, format, or enhance 
items in your documents. Some groups have a dialog box launcher button at the 
bottom right that displays a dialog box or window with more commands and options. 

Collapse the 
Ribbon 

Minimizing the Ribbon displays the Ribbon Tabs only, enabling you to see more lines 
of text in the document on screen. 

Insertion Point 
 

This symbol indicates the cursor position in a document. In a new blank document, it 
displays at the top of the page. 

Status Bar Displays document information such as current page, total number of words, proofing 
errors, language, as well as the View buttons and the Zoom slider. 

View Buttons 
 

Quickly alternate between document views. Each view offers advantages based on 
document type, use Print Layout to see the overall layout of the document; Full Screen 
Reading to view the entire document in book layout; Web Layout to view documents 
saved as web pages; Outline view to organize headings, and Draft view to focus on 
entering or editing text. 

Zoom Slider 
 

Click the buttons at either side of the slider to increase or decrease the zoom 
percentage by 10%, or drag the slider button to choose a particular zoom percentage. 
Word displays the current zoom percentage in the Zoom level button, at the right of 
the slider. You can also click this button to set a custom or specific zoom percentage. 

The previous screen displays commonly used areas of the Word screen. As you can customize the screen’s 
appearance, not all parts always appear. For instance, you can choose to turn the ruler on, that is for precise 
alignment of financial reports. You can also set up defaults, such as the font or the margins, for each new 
document. 

ScreenTips help identify buttons or elements on the tabs of the Ribbon and the screen. To view a 
ScreenTip, position the mouse cursor on the item. A tip then displays the name of the button along with a 
description of its purpose. For some items, a keyboard shortcut may also display as an alternative for 
activating this feature. 
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You can choose to show or hide a number of the elements shown in this section. In most cases, set items 
by clicking the File tab, clicking Options and then clicking the General category. 

Using the Quick Access Toolbar 
The Quick Access Toolbar, at the left of the title bar above the Ribbon, contains buttons for frequently used 
commands. By default, this toolbar contains the Word control icon, Save, Undo, Redo and Customize Quick 
Access Toolbar buttons. Use the last button to customize or display those commands you use frequently, 
such as new blank document, print, or spell check. 

 
To move the Quick Access Toolbar to below the Ribbon: 

 Click Customize Quick Access Toolbar and then click Show Below the Ribbon; or 

 right-click the Ribbon and then click Show Quick Access Toolbar Below the Ribbon. 

Using the Ribbon 
The Ribbon can help you quickly find the commands you require. Commands are grouped on tabs with 
each tab relating to a type of activity, such as inserting items into a document, changing the view of your 
document, or formatting text in the document. You can customize the Ribbon to display those commands 
you use frequently in a particular order, or to add or remove commands for a Ribbon tab. 

 
To reduce screen clutter, contextual tabs appear only when they are applicable, for example, Picture Tools, 
Header and Footer Tools, Table Tools. 

 

 Word control 
 icon Undo Redo 

 Save Customize Quick 
  Access Toolbar 
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A button that appears in a different color or has an outline is active; many of these de-activate when you 
click the same button or click another choice. For instance, the Bold command can be applied to selected 
text by clicking that button; to turn off the boldface, click the same button again. If you want the text to be 
larger, click the down arrow for the Size button and choose the required size. When you need to change 
the font size again, click the down arrow for Size and then select the new size. 

When the Ribbon displays different choices, as with the Picture Styles list shown in the previous screen, one 
item will have a border around it to indicate it is active. To see how the text would appear with another 
style, point the mouse on one of the other items and Word displays the effect. 

Each tab on the Ribbon contains groups with similar commands, for example, the Home tab has a group 
called Font that contains buttons for formatting text characters; the Insert tab contains a group with 
different types of graphics or illustrations that can be inserted into a document. 

If a group shows a feature with a scroll bar, it also has a 
button below the bottom scroll button that you can click 
to display the full list or gallery for that option.  

This is the More button which, when clicked, displays a 
gallery with more options as seen in the following image. 
As you point the mouse cursor at an option, Word displays 
a Live Preview showing how the selected item will appear 
if you apply this feature. You can turn off this feature in 
the Word Options. 

Click the  button at the lower right of a group to show a 
corresponding dialog box, window, or task pane with 
more options for this feature. Task panes appear at the left 
or right side of the screen. This button displays the name 
of the item that appears when you click the button. 

 

  
 Dialog Box Window/Task Pane 
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With the dialog box, you can select items from the lists, use the arrow for a list box to display more choices 
for that list, or click a command to turn the feature on or off. It may display a preview of the changes. 

A task pane usually contains options specific to the feature as seen in the preceding graphic that focuses 
on the styles currently available. Another task pane is the Office Clipboard that displays any item that has 
been cut or copied. 

The Ribbon can be collapsed or minimized if you want to show more of your document or you do not want 
to display the Ribbon. To collapse the Ribbon: 

 Click the  button at the far right of the top of the Ribbon, or 

 double-click any of the ribbon tabs, or 

 right-click anywhere on the Ribbon and then click Collapse the Ribbon, or 

 press + . 

To show the Ribbon again, repeat any of the previous steps used to collapse the ribbon. 

You can also click the Ribbon Options button for methods to display or hide the ribbon: 

 
You can access the Ribbon using the keyboard; some users consider the keyboard a faster method for 
accessing commands. There is also consistency between Windows programs as some keyboard shortcuts 
are the same, such as pressing +  to copy, +  to save, or +  to print. 

To access the Ribbon using the keyboard, press  or  to display the keyboard buttons for the 
commands in the Ribbon. 

 
When you press the key for the appropriate feature, Word displays the next set of keys you can use to 
select a command or feature. For example, pressing  displays the Home tab. 

 

If you then press  you access the Line Spacing command which, in this case, displays a menu with more 
options. 
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You can also use the keyboard to: 

 Access another tab, with the Ribbon active, press  or  to move to the appropriate tab. 

 Change the highlight or focus from the active tab, the status bar, or your document by pressing . 
For example, to switch view modes, press  to move the focus from the document to the status bar. 
Then press  to move to the Full Screen Reading button, and when it is highlighted, press . 

 Display a shortcut menu for the selected command by pressing + . 

 Move from the tab to the command in the first group by pressing . Continue pressing  to 
move to the next command, or +  to move to the previous command. This only occurs once 
you press  or  to display the keyboard shortcuts on the Ribbon. 

 To activate the selected command, press . 

 To exit or cancel a selection at any time, press . You may need to press  more than once to 
return to your document. 

Using the Backstage 
When you click the File tab, Word displays the Backstage view for you to select a command 
to manage your files. This view is available for all the Office programs, setting a consistent 
look and location for users to use when they want to manage their files. 

When active, the panel at the left displays a number of commands you can use to store or 
share your files. You can also view information about your Microsoft account, switch to 
another user, add/modify properties for files, or customize options for the program such as 
adding a theme, changing the display colors, setting the number of recent documents or 
setting the default file format to save documents. 

Each command displays a screen with more options for you to select. Simply click a 
command to view the options for that command.  

When you want to exit Backstage view and return to editing your document, simply click 
the  at the top left corner. 

Working with Text 
Typing (keyboarding) involves using the keyboard to input text into the document displayed on the screen. 
Editing involves performing such tasks as inserting and deleting single characters, words or multiple lines of 
text, as well as inserting and deleting blank lines between paragraphs. The following are the basic concepts 
of typing and editing text in Word: 

Insertion 
Point 

The vertical blinking bar on the screen shows where you currently are in the document; 
it moves to the right as you type new text. This bar is also called the I-beam or cursor. 

Deleting Text To delete a character to the right of the insertion point, press . To delete a 
character to the left of the insertion point, press . 

Word Wrap 

 

When you have typed enough words to fill a line, the next word automatically wraps to 
the next line. Press  at the end of each paragraph of text. 

Blank Lines 

 

A blank line is a paragraph with no text. To insert a blank line, press . This places 
a paragraph mark (¶) into the document and adds space between paragraphs. To 
remove a blank line, move to the paragraph mark and delete it as if it were a text 
character. 

Note: The paragraph mark (¶) will only appear when  (Show/Hide ¶) is selected. 
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Moving Around in the Document 
The insertion point indicates the location where Word will insert new text or pasted items. You can use 
either the mouse or the keyboard to navigate around a document. 

To use the mouse to move the insertion point to a new location in the document, point and click at the 
desired new location. 

Listed below are some keyboard methods to move quickly in a document. 

Desired Movement Press 
Next character  
Previous character  

Next word +  
Previous word  +  
Beginning of line  

End of line  
Beginning of document  +  

End of document +  

Next line  

Previous line   

Next paragraph +  

Previous paragraph +  
Next screen  
Previous screen  

Next page +  

Previous page +  

Go to page +  or  

 When you have a multiple page document, use the vertical scroll bar to move or scroll the view of the 
screen through the document from top to bottom and vice versa. 

 When the document is wider than the screen displays, use the horizontal scroll bar to move or scroll 
the view from side-to-side, across the document. 

 When you drag the scroll box along the vertical scroll bar, a ScreenTip displays your position in the 
document, similar to . This may be a page number or heading text, depending on how your 
document is set up. 

 You can also use the wheel on the mouse to move up or down in the document. 

 You can use the previously listed navigation tools to move left or right by one or more words. This 
applies to any keyboard options when moving around a document. 

 

Learn the Skill 
This exercise provides practice with entering text and demonstrates how words wrap. You 
should already have a blank document on the screen. If not, start Word, and double-click Blank 
document to begin the exercise. 

1 In the blank document on your screen, type: Mr. Alexander Montgomery and then press . 

Notice how Word allows you to enter text directly onto the screen and, when you pressed , the 
cursor moved to the beginning of the next line. 
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2 Type the following text as shown, pressing  only when you see the ¶ symbol (your text will wrap 
at a different location than the following as the text is formatted to fit the layout used in this book): 

Eco Tours & Travel¶ 
813 – 1140 Cummins Street¶ 
Bellis Plaza¶ 
Vancouver, WA  98667¶ 
¶ 
Dear Mr. Montgomery:¶ 
It was a pleasure meeting you at the trade show last week and learning about 
the specialized tours your company offers.¶ 
I would like to continue our discussion regarding the possibility of our 
companies partnering to offer additional services to our customers, 
continuing and expanding eco adventures to the public.¶ 
You indicated you would be out of town for the next two weeks. Please give me 
a call at 206 555 6262 at your earliest convenience to schedule a meeting. I 
look forward to hearing from you shortly.¶ 
¶ 
Sincerely,¶ 
¶ 
¶ 
Andrew McSweeney¶ 
Tour Director¶ 
¶ 

  As you typed the information into your document, you will have noticed that the text wrapped from 
the right side back to the left side when you ran out of space. This is word wrap which enables you to 
concentrate on entering your text. Word, by default, uses line spacing of 1.15 and results in the “extra” 
space between the lines of text. You will learn how to change the line spacing along with other 
formatting options later in this courseware; at this point, we will focus on entering and editing the text 
and managing documents. 

3 Leave the document on the screen for the next exercise. 

Working with Documents 
Creating a New Document 

When Word initially starts, a blank document appears on the screen. To create a new blank document, you 
must use a series of commands. 

To create a new blank document: 

 Click File, click New, click Blank document, and then click Create, or 

 press + . 

To create a new document from a variety of pre-designed documents, called templates, click File, click 
New. Fo
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Use a pre-designed template if you are unsure how to lay out a particular type of document, such as an 
invitation, meeting agenda, or a business memo. When you click a selection in the Office.com list, the 
template appears as a preview in the new window. If this is the template you want to use, click Create; if 
not, click the arrow on either side of the preview to view the template before or after this one in the list. 
Alternatively, you can click the Close button for the window, click the  button and then choose 
another template more suitable for the type of document you want to create. 

 
An automatic number appears with each new document to identify it as a new document until you save it. 
For example, if you have three new Word documents open and you create another new document, the title 
bar displays it as Document4 thereby ensuring it does not share the same name as the other three 
documents. The document numbering restarts at 1 when you start a new session of Word. 

  

Fo
r E

va
lua

tio
n O

nly



Getting Started Lesson 1 
 

 

6278-1 v1.00 © CCI Learning Solutions Inc.  11 

Switching Between Documents 
When you have multiple documents open on the screen, you can switch between documents quickly and 
easily by using one of the following methods: 

 Click the View tab, and in the Window group, click Switch Windows, or 

  
 click the Word button on the taskbar to display a preview of each open document. 

  
Once you display the preview of open documents, click the document you want to work on and Word will 
switch you to that document. 

 

Learn the Skill 
In this exercise, you will create new documents and then switch between them to add or change 
text in the documents.  

1 Press + . 

 You should now have a new blank document on the screen. 

2 Click the File tab and click New. In the row below the search field, click Cards. 
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 Notice how, in addition to displaying a variety of card templates, Word displays an additional list at the 
right where you can narrow the search. 

3 In the Category list, click Greeting Card. 

4 In the Category list, click Paper. 

5 In the Category list, click Illustration. 

 Let’s say at this point you realize you don’t want the Illustration category and want to return to the 
previous screen. In this case, all you need to do is remove the search criteria from the category list. 

6 Point the mouse cursor to the right of the Illustration category to display a Close button. 

  
7 Click the Close button to remove the Illustration category from the list. 

8 Scroll in the list to find a thank you card with a soccer image in it and then click it in the list. 

Note: If you do not have access to this template, choose from those that are available. The focus here is on 
how to create a document using a template and not on the content of the template. You will then need to 
adjust the text to match the template available to you. 

9 Click Create. 

  
 In most cases, when you create a new document using a template, the template includes some areas 

called fields that have been set up to assist you with what information to enter in that location. For 
instance, in the example we show here, the text [Type your message here] is a field that has been set 
up to allow you to enter whatever you want to appear in the final card. 
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10 Click in that box and type the following: 

  
11 Click anywhere away from the text you just entered. 

12 Leave this file open for the next exercise. 

Saving Documents 
As you begin working with documents, you need to consider how to organize your files for easy access. File 
organization includes how you name the file, where you save it, specific file type, and whether you want to 
add or change the properties of the file to help find it later. 

It is important to save your documents as you work on them to be able to use them again. To save changes 
made to the current document using the same file name, use one of the following methods: 

 Click File and then Save, or 

 on the Quick Access Toolbar, click Save, or 

 press + . 

You can use Views in the Save As dialog box to help display the folders and files to personal preferences. 

When choosing a name for the document, consider the following: 

 The file name may be a maximum of 255 characters (including the drive and folder path), and may not 
include these characters: / \ : * ? “ < > |  

 Name the file so you can identify the contents quickly. 

 Word automatically assigns a .docx extension or file type at the end of the file name. You only have to 
type in a name for the document. 

 Word provides a variety of different formats you can select, including PDF and Macintosh operating 
system-compatible files. 

 When the suggested file name appears in a shaded box, begin typing the new file name for this 
document. You can use the arrow direction keys to move anywhere in the existing file name to add or 
delete text. 

 The first time you save a new document, regardless of which method you choose to activate the Save 
command, the Save As dialog box displays by default. The next time you want to save changes to the 
existing document, use any of the Save methods to immediately save the document in the 
background. 

 To save an existing document with a new name, click File and then click Save As. Fo
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 To save a document as a different file type, such as document compatible with an earlier version of 

Word, use Save as type in the Save As dialog box to find the appropriate file format. 

  
 By default, Windows sets up the Documents library to store files and Word draws on this. You are not 

restricted to this folder and can: 

– Create your own folders to help organize files by clicking New folder on the command bar in 
the Save As dialog box. 

– Save in any location to which you have access, for example, hard drive, thumb drive, flash disk, 
network drive. 

 If you need to save the file in a different location, you can navigate from the Documents library to 
another drive, such as a network drive or a flash/thumb drive. 

If the location is a remote site such as SkyDrive or a network drive on a remote server or you want to share 
this document with others, use the Share command from the File menu instead. From here you can also 
choose from a variety of methods to share or send files in a file format different than the original. 

Fo
r E

va
lua

tio
n O

nly



Getting Started Lesson 1 
 

 

6278-1 v1.00 © CCI Learning Solutions Inc.  15 

 
If you are unsure whether you have saved a file previously, check the title bar or use Save As to give the file 
a different name, thereby ensuring you have a copy of the current document on screen. 

If the file already exists in one location, you can save the same file to another location. Be careful with files 
which have the same name in different locations as you will need to use other tools to help you and others 
determine which one is the most current or valid version. 

To view the file type or extension, turn on this option using File Explorer. Click Organize, Folder and 
search options, and then on the View tab, deselect the Hide extensions for known file types. Showing 
file types is helpful when determining which file you want to use such as when two files have the same 
name and one shows the Word 2013 format (.docx) while the other shows the Word 2003 format (.doc). 

Using Document Properties 
Document properties provide information to assist in locating this file based on specific search criteria. 
How much information you enter will depend on standards set up in your office, or which information you 
want to use to find documents later. 

To view the properties for the current document, click File, click Info, and review the information in 
Backstage. 

 
To add properties for the current document, in the right pane, click the field you want to change.  
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To add properties to the file using a method other than in Backstage, click 
Properties at the right of the Backstage view. 

 
 

Show 
Document 
Panel 

Display a panel above the document on the Word screen where you can add general 
information for this document. You can also click Document Properties at the top left of 
this panel to access the Advanced Properties option. 

 

Advanced 
Properties 

Add or customize properties for the document, such as who checked this document, its 
subject or category. Each tab in this dialog box displays different information for viewing or 
modifying. For instance, use the Summary tab to insert specific information for the file, 
similar to using File Explorer to look at the properties for this file. 

 

Protecting the Document 
To protect a confidential document, you can add a password to it at any time. Although this is a document 
and not a login ID, the rules for selecting a password should still apply, especially if you want to ensure 
document confidentiality. Some general guidelines in selecting a password include: 

 Choose a password that is logical to you, but not obvious to someone trying to guess the password. 

 Refrain from using any personal information such as the name of a spouse, child, or pet. 

 Avoid passwords that may seem logical, but are easy to guess, such as Jan2013, AM06-13, 123456789. 

 Use a minimum of six characters, although eight provides a higher level of security. 

 Use a mixture of upper and lower case characters as well as including some numbers or symbols, for 
example, ToLanO-aM3, am-TOL=0613. 
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To add a password to a document, open the document, click File and ensure you are viewing the Info 
screen in Backstage. Then click the Protect Document command. 

 
Click Encrypt with Password to enter the password you want to apply to this document. 

 
Once you click OK you will be prompted to enter the password again to verify you actually do want to 
apply a password to the document. Ensure you type the password exactly as it was entered in the previous 
screen. 

 
Click OK to apply the password. 

 
Word now verifies that a password has been applied to this document. However, you will still need to save 
the document once more to enforce the password on the document. 

To remove the password, repeat the steps to apply a password and then delete the password. Remember 
to save the document again to remove the password. 
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Maintaining Compatibility 
Occasionally when working with documents saved in a different format than Word 2013, you may find 
there are incompatibilities working with the file, for example, formatting options, tab alignments or 
SmartArt diagrams converting to a single image. Word provides tools to check the document to ensure it is 
compatible with other Word versions. 

To check whether there are problems with converting your document to a different file format than Word 
2013, click File, click Info, click Check for Issues, and then click Check Compatibility. 

 
Potential issues between the versions appear in the list and you need to decide whether to continue saving 
the file in this file format or return to the document to make appropriate changes. For instance, SmartArt is 
a feature that did not exist in versions earlier than Word 2007. If you need this document to be available in 
a format other than Word 2007 or higher, this diagram will appear in the document, but cannot be 
changed. 

Closing a Document 
Once you have finished editing or revising a document, you should close the document to clear the screen 
and memory, enabling you to create or open another document without leaving old documents on your 
screen. Closing your document is much like closing a book and putting it back on the shelf before opening 
another one. 

Although you can have multiple documents open at one time, it is best to close those you are not working 
on. This saves on memory and processing time. 

As Word displays each document in its own window, you can use one of the following methods to close a 
document: 

 Click File and then Close, or 

 press +  or + , or 

 point at the Word button in the taskbar and then, in the live preview window displaying the currently 
open documents, click the  button for that file. 

Using these methods to close documents keeps the Word application open on the screen. If you want to 
close the Word application at the same time as the document, click the  Close button. 

If you add or change something in a new or existing document that has not been saved yet, Word always 
prompts with the option of saving the document. 
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When you close all documents in Word, the screen appears similar to: 

 
Notice no options are available to you other than the File tab as a reminder that there are no documents 
active in Word, and you must now create a new document or open an existing one before the features 
become available. 

 

Learn the Skill 
 In this exercise, you will save two of your newly created documents. 

1 With the greeting card document from the previous exercise still visible on the screen, in the Quick 
Access Toolbar, click  Save. 

  

Fo
r E

va
lua

tio
n O

nly



Lesson 1 Getting Started 
 

 

20  6278-1 v1.00 © CCI Learning Solutions Inc. 

2 Click Computer to indicate this is the location where you want to save the document. 

  
3 Click Browse and then navigate to where the student data files are located (for example, Desktop\3250 

Student Data folder). In the File name field, select the suggested text and then type: Thank you to 
soccer coach ‐ student and press . 

 Notice the title bar now displays the name of this file as confirmation that the file has been saved 
successfully with this name. 

Switch to another document to save it with a descriptive file name. 

4 On the taskbar, point at the Word icon and switch to the letter to Eco Tours & Travel. 

5 Press +  to save this document. 

 The Save As screen in Backstage should appear. 

6 Click Computer as the location, if necessary. 

  
7 Click Desktop and then navigate to the 3250 Student Data folder. In the File name field, type: Letter 

to Eco Tours & Travel – Student and press . 
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8 Click File and, with the Info screen active in Backstage, click Protect Document and then click Encrypt 
with Password. 

 For the purpose of demonstrating how to apply a password, we will use a simple password. In actual 
practice, you should choose one that will be more secure. 

9 In the Encrypt Document window, type: tolano as the password and click OK. 

10 In the Confirm Password window, type: tolano again as the password and click OK. 

11 In the panel at the left, click Save. 

Now make some changes to the document. 

12 Click at the end of the Eco Tours & Travel line and press + . Then press  to remove 
the extra blank line below. 

  

 When you press + , you are inserting a line break instead of using a paragraph break 
marker. This keeps the text together with the next line of text, removing any spacing between the lines 
as seen in the previous images. Line breaks are often used when you want to end a line within a 
paragraph (for example, you are inserting a web address that wraps to a second line as it is too long to 
fit on one line), or to keep lines together such as with the address in this letter. 

13 Repeat step 13 with the next two lines of the address: 

  
14 Click in the blank line between the last paragraph of the letter and the closing salutation. Delete this 

blank line. 

  
15 Press +  to quickly save the changes made to this document. 

Try checking the compatibility if you intend to send this document to the coach who is using an earlier 
version of Word on his computer. 

16 On the taskbar, point at the Word icon and click the soccer greeting card. 

17 Click File and in the Info screen, click Check for Issues. Then click Check Compatibility. 

18 Read the screen and click OK. 

 The document can now be opened by the coach although he will not see any special effects that were 
included with this template as these are not compatible with an earlier version of Word. 

19 On the Quick Access toolbar, click Save for this document. 

20 Click the  Close button for this document and the Word application. 

21 Press +  to close the next document. If this is one of the blank documents, it should close from 
the screen. 
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22 If presented with a window asking you to save, not save, or cancel the action, click Don’t Save to close 
the blank document without saving. 

23 When the letter appears, click File and then click Close. 

24 Close any other documents that may be open on the screen, without saving. 

 Word should still be open on the screen, but only the ribbon is active. 

Opening a Document 
You can open a document from any location to the screen for further processing. You can open as many 
documents as needed; the only limitation is the amount of memory available on your system to handle 
multiple documents. 

Use one of the following methods to open a document: 

 Click File, click Recent, and then click the file from the list of recent documents; or 

 click File and then click Open; or 

 press +  or + . 

 
As you open documents, Word displays the files in the same order as you opened them, with the most 
recent at the top of the list. As you reach the maximum number of files that show in this list, the oldest 
drops from the list. You can click the pin icon at the right of the file name to make this file always available 
in the list until it is unpinned. By default, you can see a list of up to 25 recent documents at a time; this 
number can be customized from 0 to 50. 

To select a file in the Recent Documents list, click that file from the list. As you point to the file, a  appears 
at the right of the file which you can use to pin the file to the list. 

To open a document stored in a different location, click the appropriate location from the list and then 
navigate to the folder where the file may be stored. Different options appear for the location you select. For 
instance, the following image displays if you want to retrieve a document from your SkyDrive account: 
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SkyDrive is a web-based storage location for files that can be accessed via an Internet connection to a 
dedicated Microsoft server. The advantage of using SkyDrive is the ability to save (store) or open (retrieve) 
documents wherever you are, as long as the computer you are using has Internet access. You must also 
have a registered Microsoft account before you can use SkyDrive to store or retrieve files. 

If there is a location that you may use frequently, you can click the Add a Place option to navigate to and 
then add that location to the list for quick access, for example, network drive/SharePoint location. 

If you want to open a file stored on your computer (or your network), click Computer. 

 
When you click the Browse button, the Open dialog box appears. Use the Open dialog box to navigate to 
different drives and folders to find and select the file you want. 
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Notice that the option to the right of the File name box indicates that Word will display All Word 
Documents. This is the default setting. All Word Documents includes file formats that are native to 
Microsoft Word, including .docx, .docm, .dotx, .doc, .dot, and others. 

You can, however, search for files saved in formats that are not native 
to Word. Click All Word Documents to open the drop-down list. 

The options in the drop-down list indicate that Word can open several 
types of documents. Note that not all non-native files will open 
directly in Word. Some formats can be successfully converted so that 
Word can use them while others may result in an error message such 
as following: 

  

These errors are usually a result of the type of content in the file which may not be recognized as one that 
can be converted into an acceptable format for a word processing document, such as the case with images. 
Some files can be available for use with specific features such as a database file when working on a mass 
mailing project. 

Importing Files 
An alternative to opening files with the Open command is to import or insert the files into the Word 
document. You may choose to use this method when a Word document does not open, or if you want to 
insert text from one document directly into another document without using copy and paste, such as an 
Excel worksheet or chart. Any formatting that existed in the imported document updates to reflect the 
current formatting or styles of this document. You can import content from a file into a new or existing 
document. 

To import an item into a Word document, click the Insert tab and, in the Text group, click Object. 
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Use Object if there is an object in a file that you want to import into this document.  

Click Text from File to import text into the current document, and then navigate to where the file is stored. 

 

Depending on the document you imported, you may need to adjust or apply formatting as required. 

Opening PDF Files 
This feature demonstrates how powerful a program such as Word is, giving you access to documents you 
previously could not access without the appropriate software for the file format. Portable Document 
Format, or PDF, is a file format used to restrict editing of the file contents, to make a file smaller so it can be 
set up as a link on a web site for downloading, or to maintain the design layout and format of a file for 
distribution to others. 

 
Once you click OK, the PDF document opens as a Word document and you can edit it as if it had been a 
Word document originally. When changes are complete, you can choose to save it as a Word document, or 
choose another file format, including PDF. 
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Learn the Skill 
In this exercise, you will open a variety of documents, including a PDF document for editing, and 
then import a text file into a PDF document. 

1 Click File and then click Open. 

2 Click Computer and then click the name of the folder where the student data files are located. 

 This location appears in the list as it was used when you saved the documents previously. Notice how 
Word conveniently places it in the Recent Folders area for quick access. 

3 Select the Corporate Profile document and then click Open. 

 This document now appears on your screen. 

4 Press + . 

 Word now displays the list of recently used documents for you to select from. 

5 Click the letter to Eco Tours to open this document. Type: tolano as the password to display the 
contents of the file and press . 

Try opening a file in a different file format than Word. 

6 Click File, click Open, click Computer and then click the folder for the student data files. 

7 Select the Staff Retreat Presentation Notes document and then click Open. 

This file was saved in the .rtf or Rich Text Format, a format that is recognized by Word as one it can 
open automatically. Saving a file using the rtf format generally guarantees that the basic formatting 
applied to text remains with the file, regardless of which program was used to create it. 

Now try opening a PDF file to add some text. 

8 Click File, click Open, click Computer and then click the folder for the student data files. 

9 Select the Marketing Strategy document and click Open. 

10 Click OK at the message indicating the PDF file will be converted into a Word format. 

Add text from an .rtf file to this edited document. 

11 Move to the end of the document in preparation to insert some text into this location. Click the Insert 
tab and then, in the Text group, click the arrow for Object. Click Text from File. 

12 Ensure you are viewing the files for the student data files (if not, navigate to this location), select the 
Sample Prize List file and click Insert. 
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 Your file should appear similar to the following: 

 
13 Click Save on the Quick Access toolbar to save the document as a Word file. 

14 In the File name field, type: Marketing Strategy with prize list – Student and click Save. 

15 Close this file and then close all remaining files without saving. 

Lesson Summary
This lesson teaches you to create simple documents and introduces you to some file management tools 
available in Word. Upon completion of this lesson, you should be able to: 

 identify elements on the screen 

 use the Quick Access Toolbar 

 use the Ribbon 

 work with text 

 move around the document 

 use Backstage to save, open, or create new documents 

 switch between documents 

 save in different file formats 

 close a document 

 add document properties 

 open and edit PDF files 
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Review Questions 
1. Explain how the Ribbon is organized. 

2. Provide examples of when you might use a template to create a new document. 

3. Explain why you would save a file in a format other than the Word 2013 document format. 

4. Explain why you might want to save a document to your SkyDrive account. 

5. Provide an example of the type of information you might enter for a file’s properties. 

6. To protect a document you are sending to your lawyer, which password would you consider using? 

a. lawyer 

b. password 

c. ltr-Lawyer_0313 

d. your name 

7. Why might you want to check the compatibility of a document that will be shared with others? 

8. Which option can you use to open a non-native file in Word? 

9. Why might you want to import a file instead of opening it in Word? 

10. What steps do you need to take to view the contents of a PDF file in Word? 
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